Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on UNIX
## Content

1. **Introduction**
   - About this Document ................................................................... 7
   - About Software Provisioning Manager ........................................... 7
   - New Features .................................................................................. 8
   - SAP Notes for the Installation ......................................................... 9
   - Accessing the SAP Library ............................................................... 10
   - Naming Conventions ....................................................................... 10

2. **Planning**
   - Hardware and Software Requirements ........................................... 12
     - Hardware and Software Requirements Tables ............................... 12
   - Basic Installation Parameters ....................................................... 19

3. **Preparation**
   - Creating Operating System Users and Groups ............................... 22
   - SAP Directories ............................................................................. 25
   - Using Virtual Host Names ............................................................. 29
   - Preparing the Installation Media ................................................... 29
     - Downloading and Extracting the Software Provisioning Manager Archive .................................................. 30
     - SWPM10SP<Support_Package_Number>_<Version_Number>.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation) ..................................................... 32
     - Using the Physical Media from the Installation Package ................ 33
     - Downloading Complete Installation Media ................................. 34

4. **Installation**
   - Prerequisites for Running the Installer .......................................... 36
   - Running the Installer ..................................................................... 36
   - Additional Information About the Installer ...................................... 39
     - Useful Information About the Installer ........................................ 43
     - Interrupted Processing of the Installer ........................................ 43
     - Performing a Remote Installation (Java SDT GUI only) ............... 48
     - Starting the Java SDT GUI Separately ......................................... 48
     - Running the Installer in Accessibility Mode .................................. 50
     - Troubleshooting with the Installer ............................................. 52

5. **Post-Installation Activities**
   - Gateway Configuration ................................................................. 56

6. **Additional Information** ............................................................... 57
6.1 Using Virtual Host Names. ...................................................... 57
6.2 Starting and Stopping with Commands. ............................................ 57
6.3 Uninstall. ........................................................................... 58
Document History

### Note

Before you start the implementation, make sure you have the latest version of this document, which is available at [https://support.sap.com/sltoolset](https://support.sap.com/sltoolset). System Provisioning Installation Option of Software Provisioning Manager.

The following table provides an overview on the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
<td>2017-09-11</td>
<td>Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
</tbody>
</table>

- **New Features:**
  - Media Signature Check, documented in: *New Features*, *Running the Installer*, *Preparing the Installation Media*. This feature implies that section *Creating Kernel Archives from an Existing SAP System* has been deleted from this documentation because the related option in the installer had to be removed.
  - SAP Host Agent Upgrade, documented in: *New Features*, *SAP System Parameters*, *Downloading SAP Kernel Archives (Archive-Based Installation)*
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2.4     | 2017-05-22 | Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)  
- **New Features:**  
  ○ New SAPUI5-based graphical user interface (GUI) “SL Common GUI”, documented in: *Prerequisites for Running the Installer*, *Running the Installer*, *Useful Information About the Installer*  
  ○ Cleanup of operating system users, documented in: *SAP System Parameters*, *Creating Operating System Users and Groups* |
<p>| 2.3     | 2017-02-06 | Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)                                                                                                                                                      |
| 2.2     | 2016-10-07 | Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)                                                                                                                                                      |
| 2.1     | 2016-06-06 | Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17)                                                                                                                                                      |
| 2.0     | 2016-02-15 | Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16)                                                                                                                                                      |
| 1.9     | 2015-10-12 | Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP15)                                                                                                                                                      |
| 1.8     | 2015-09-14 | Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP14)                                                                                                                                                      |
| 1.7     | 2015-04-27 | Updated version for software provisioning manager 1.0 SP08 (SL Toolset 1.0 SP13)                                                                                                                                                      |
| 1.6     | 2014-11-24 | Updated version for software provisioning manager 1.0 SP07 (SL Toolset 1.0 SP12)                                                                                                                                                      |
| 1.5     | 2014-07-07 | Updated version for software provisioning manager 1.0 SP06 (SL Toolset 1.0 SP11)                                                                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4</td>
<td>2014-03-17</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP10)</td>
</tr>
<tr>
<td>1.3</td>
<td>2013-10-28</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.2</td>
<td>2013-07-15</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.1</td>
<td>2013-04-12</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.0</td>
<td>2012-12-17</td>
<td>Initial version</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 About this Document

This documentation describes how to install a standalone Gateway instance for SAP system products based on SAP NetWeaver 7.0 and higher on UNIX using the installation tool software provisioning manager 1.0 SP21 ("installer" for short), which is part of SL Toolset 1.0 SP21.

You can find a complete list of supported SAP system products in SAP Note 1680045.

Each instance of an SAP system with an ABAP application server has a Gateway. The Gateway enables communication between work processes and external programs, as well as communication between work processes from different instances of SAP systems.

You can also install a standalone Gateway. With the standalone Gateway, you can install the Gateway service separately from the SAP system. In this case, the SAP system can access each external Gateway under a different RFC connection.

Note

There is no difference between a standalone Gateway instance for a Unicode system and a standalone Gateway for a non-Unicode system.

1.2 About Software Provisioning Manager

Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of provisioning tools, such as SAPinst. Before you run it, we recommend that you always download the latest version of Software Provisioning Manager 1.0. Software Provisioning Manager 1.0 is part of the Software Logistics Toolset 1.0 ("SL Toolset" for short). This way, you automatically get the latest fixes and supported processes. For more information about Software Provisioning Manager as well as products and releases supported by it, see SAP Note 1680045 and http://scn.sap.com/docs/DOC-30236. “SAPinst” has therefore been renamed to “Software Provisioning Manager 1.0” in this documentation. However, the term “SAPinst” is still used in:

- Texts and screen elements in the Software Provisioning Manager GUI
- Naming of executables, for example sapinst.exe

In the following, we generally refer to Software Provisioning Manager 1.0 as the “installer”. We only use the term “Software Provisioning Manager 1.0” if this is required for technical reasons.
Related Information

Preparing the Installation Media [page 29]

1.3 New Features

The table below provides an overview of the new features in Software Provisioning Manager.


Table 2:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Signature Check</td>
<td>The signature of media is checked <strong>automatically</strong> by the installer during the <em>Define Parameters</em> phase while processing the <em>Media Browser</em> screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060. For more information, see <em>Preparing the Installation Media</em> [page 29] and <em>Running the Installer</em> [page 39].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SAP Host Agent Upgrade During the Installation (Optional)</td>
<td>During the <em>Define Parameters</em> phase of the installation, the installer prompts you whether you want to upgrade an existing version of the SAP Host Agent on the installation host. If there is no SAP Host Agent on the installation host, it is installed automatically without prompt. For more information, see <em>Basic Installation Parameters</em> [page 19].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SL Common GUI with SAPINST 7.49</td>
<td>With the new installer framework version SAPINST 7.49, you can now use the new SAPUI5-based graphical user interface (GUI) “SL Common GUI”. For more information, see <em>Useful Information About the Installer</em> [page 43], <em>Running the Installer</em> [page 39], and SAP Note 2336746.</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Cleanup of Operating System Users</td>
<td>You can now specify during the <em>Define Parameters</em> phase that the operating system users are to be removed from group sapinst after the execution of the installer has completed. For more information, see <em>Operating System Users in Basic Installation Parameters</em> [page 19].</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Verification of Integrity of Data Units in Software Provisioning Manager** | The integrity of data units extracted from the Software Provisioning Manager archive is verified. For more information, see [Downloading and Extracting the Software Provisioning Manager Archive](https://support.sap.com/notes) [page 30].  
In addition, check SAP Note 1680045 whether additional information is available. | Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19) |
| **Support of Linux on IBM Power Systems (little endian)** | Software Provisioning Manager supports as of now Linux on IBM Power Systems (little endian) as operating system platform for SAP systems based on SAP NetWeaver 7.5 and higher. For more information, see SAP Note 2378874. | Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19) |
| **Archive-Based Installation**               | You can now download the required installation archives for the SAP Gateway installation, instead of using the complete SAP kernel installation media. For more information, see [SWPM10SPSupport_Package_Number_Version_Number.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation)](https://support.sap.com/notes) [page 32]. | Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18) |
| **System Provisioning for SAP NetWeaver 7.5 and SAP NetWeaver 7.5-based Products** | All system provisioning tasks (installation, system copy, system rename) are available for the new SAP NetWeaver 7.5 release.  
The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID `<SAPSID>`, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5. | Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15) |
| **Feedback Evaluation Form**                 | SAP SE’s aim is to provide fast and efficient procedures. To evaluate the procedure you just carried out, we need information generated by the tool during process execution and your experience with the tool itself. A new evaluation form contains a simple questionnaire and XML data generated during the procedure.  
Port 4239 is used for displaying the feedback evaluation form. | Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12) |
| **Option Verify Signed Media**               | The digital signature ensures that the signatory of a digital document can be identified unambiguously and signatory’s name is documented together with the signed document, the date, and the time.  
For more information, see SAP Note 1979965. | Software Provisioning Manager 1.0 SP06 (SL Toolset 1.0 SP11) |

### 1.4 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service Marketplace at [https://support.sap.com/notes](https://support.sap.com/notes).
Table 3: SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1680045</td>
<td>Release Note for Software Provisioning Manager 1.0</td>
<td>Remarks, annotations, and corrections discovered after publication of the document Software Provisioning Manager</td>
</tr>
<tr>
<td>2378874</td>
<td>Install SAP Solutions on Linux on IBM Power Systems (little endian)</td>
<td>Information about how to install SAP solutions on Linux on IBM Power Systems (little endian)</td>
</tr>
</tbody>
</table>

1.5 Accessing the SAP Library

The references to SAP NetWeaver Library documentation in this installation guide always refer to the following on SAP Help Portal:

Table 4:

<table>
<thead>
<tr>
<th>Product and Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.0x</td>
<td><a href="http://help.sap.com/nw70">http://help.sap.com/nw70</a>&lt;Enhancement Package&gt; &lt;Application Help&gt; Function-Oriented View</td>
</tr>
<tr>
<td>SAP systems based on SAP NetWeaver 7.3</td>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a> &lt;Application Help&gt; Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP systems based on SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a> &lt;Application Help&gt; Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP systems based on SAP NetWeaver 7.4</td>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a> &lt;Application Help&gt; Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP systems based on SAP NetWeaver 7.5</td>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a> &lt;Application Help&gt; Function-Oriented View: English</td>
</tr>
</tbody>
</table>

1.6 Naming Conventions

In this documentation, the following naming conventions apply:

> **Note**

From a technical point of view, the standalone Gateway is set up like an SAP system with its own SAP system ID (SAPSID), its own operating system users, and its own directory structure.
• installer refers to software provisioning manager 1.0.
• SAP system refers to standalone gateway.
• instance refers to standalone gateway instance.
2 Planning

2.1 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the Gateway.

⚠️ Caution

If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

Process Flow

1. Check the Product Availability Matrix at http://service.sap.com/pam for supported operating system releases.
2. If you want to use the standalone Gateway for a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
   - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
     - The set of applications to be deployed
     - How intensively the applications are to be used
     - The number of users

2.1.1 Hardware and Software Requirements Tables

The standalone Gateway host must meet the following requirements:

ℹ️ Note

The information here is not intended to replace the operating system documentation. For more information, see your operating system documentation.
Table 6: General Installation Information for Your Operating System

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>Before you start the installation, make sure that you have read SAP Note 1972803. In addition, we also recommend that you check the information available in the SAP on AIX space on the SAP Community Network at <a href="http://scn.sap.com/community/aix">http://scn.sap.com/community/aix</a>.</td>
</tr>
<tr>
<td>HP-UX</td>
<td>Before you start the installation, make sure that you have read SAP Note 1075118. In addition, we also recommend that you check the information available in the SAP on HP-UX Best Practices space on the SAP Community Network at <a href="http://scn.sap.com/community/hp-ux">http://scn.sap.com/community/hp-ux</a>.</td>
</tr>
<tr>
<td>Linux</td>
<td>Before you start the installation, make sure that you have read the SAP Notes for your Linux distribution listed in the central SAP Note 171356. In addition, we also recommend that you check the information available in the SAP on Linux space on the SAP Community Network at <a href="http://scn.sap.com/community/linux">http://scn.sap.com/community/linux</a>.</td>
</tr>
<tr>
<td>Solaris</td>
<td>Before you start the installation, make sure that you have read SAP Note 1669684. In addition, we also recommend that you check the information available in the SAP on Oracle Solaris space on the SAP Community Network at <a href="http://scn.sap.com/community/oracle-solaris">http://scn.sap.com/community/oracle-solaris</a>.</td>
</tr>
<tr>
<td>Linux for System z</td>
<td>Before you start the installation, make sure that you have read SAP Note 81737.</td>
</tr>
</tbody>
</table>

Table 7: Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing units</td>
<td><strong>For application server instances and database instances</strong>: The number of physical or virtual processing units usable by the operating system image must be equal to or greater than 2. \nExamples of processing units are processor cores or hardware threads (multithreading). In a virtualized environment, ensure that adequate processor resources are available to support the workloads of the running SAP systems.</td>
</tr>
<tr>
<td>Optical media drive</td>
<td>ISO 9660 compatible</td>
</tr>
<tr>
<td>Requirement</td>
<td>Values and Activities</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Hard disk space      | • **General Requirements:**  
|                      |   ○ 2 GB of temporary disk space for each required physical installation media - or alternatively the downloaded SAP kernel archives - that you have to copy to a local hard disk. For more information, see *Preparing the Installation Media* [page 29].  
|                      |   ○ If you prefer downloading the installation archives instead of using the physical media, you require 1 GB of temporary disk space for the archives that you have to copy to a local hard disk. For more information, see *SWPM10SPSupport_Package_Number_Version_Number.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation)* [page 32].  
|                      |   ○ 2 GB of temporary disk space for the installation.  
|                      |   ○ If an advanced disk array is available (for example, RAID), contact your hardware vendor to make sure that the data security requirements are covered by this technology.  
|                      | • **Instance-Specific Requirements:**  
|                      |   The standalone Gateway instance requires 1 GB of hard disk space minimum.  
| RAM                  | **Note**  
|                      |  
|                      | **AIX:** Keep in mind that the operating system itself requires about 10% of the available RAM.  
|                      | **End of 'Platform': AIX**  
|                      | The standalone gateway instance requires 1 GB RAM minimum.  
|                      | **End of 'Platform': HP-UX**  
|                      | **HP-UX:** Refer to SAP Note [1112627] for the commands to display the RAM size on HP-UX.  
|                      | **End of 'Platform': HP-UX**  
|                      | **End of 'Platform': Linux**  
|                      | **Linux:** Refer to SAP Note [1382721] for the commands to display the RAM size on Linux.  
|                      | **End of 'Platform': Linux**  
|                      | **AIX:** Paging space  
|                      | You need hard disk drives with sufficient paging space. You can calculate the required paging space as follows: 2^* RAM, at least 20 GB  
|                      | **HP-UX:** Swap space  
|                      | You need hard disk drives with sufficient space for swap. You can calculate the required swap space as follows: 2^* RAM, at least 20 GB  
|                      | **Linux:** Swap space  
|                      | You need hard disk drives with sufficient space for swap. You can calculate the required swap space as follows: 2^* RAM, at least 20 GB  
|                      | **Oracle Solaris:** Swap space  
|                      | You need hard disk drives with sufficient space for swap. You can calculate the required swap space as follows: 2^* RAM, at least 20 GB  

---

*Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on UNIX*  
*Planning*
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| **AIX**: Operating system version | Your operating system platform must be 64-bit.  
  Check the Product Availability Matrix (PAM) at [http://support.sap.com/pam](http://support.sap.com/pam) for supported operating system versions.  
  Contact your OS vendor for the latest OS patches.  
  Minimal OS requirements for the specific SAP Kernel releases are listed in SAP Note 1780629.  
  You require at least AIX 6.1 TL7 SP10 to be able to run the installer. |
| **HP-UX**: Operating system version | Your operating system platform must be 64-bit.  
  Check the Product Availability Matrix (PAM) at [http://support.sap.com/pam](http://support.sap.com/pam) for supported operating system versions.  
  To check the operating system version on your installation hosts, use the following command:  
  \( \texttt{uname -r} \)  
  See SAP Note 939891 for information about support time frames of HP-UX. |
| **Linux**: Operating system version | Your operating system platform must be 64-bit.  
  Check the Product Availability Matrix (PAM) at [http://support.sap.com/pam](http://support.sap.com/pam) for supported operating system versions.  
  Contact your OS vendor for the latest OS patches.  
  To check the operating system version on your installation hosts, use the following command:  
  \( \texttt{cat /etc/*-release} \) |
| **Oracle Solaris**: Operating system version | Your operating system platform must be 64-bit.  
  Check the Product Availability Matrix (PAM) at [http://support.sap.com/pam](http://support.sap.com/pam) for supported operating system versions.  
  To check the operating system version on your installation hosts, use the following command:  
  \( \texttt{/bin/uname -r} \) |
| **SAP Kernel Releases and Versions** | To use regular Software Provisioning Manager (GWPM10<Version>.SAR) with SAP kernel 7.49 or higher on RHEL 6 or SLES 11 or Oracle Linux 6, you must install the required `libstdc++` RPM packages. For more information, see SAP Note 2195019. |
| **AIX**: Kernel parameters | |
To run an SAP system, make sure that you check and, if necessary, modify the HP-UX kernel.

**Caution**

We recommend that a UNIX system administrator performs all kernel modifications.

Proceed as follows:

1. Check SAP Note 172747 for recommendations on current HP-UX kernel parameters.

   **Caution**

   If a kernel value is already larger than the one suggested in the SAP Note, do not automatically reduce it to match the SAP requirement.

   You have to analyze the exact meaning of such a parameter and, if required, to reduce the parameter value. In some cases this might improve the performance of your SAP applications.

2. If necessary, modify the kernel parameters in one of the following ways:
   - Manually, as described in SAP Note 172747.
   - Interactively, using the HP-UX System Administrator Manager (SAM) or System Management Homepage (SMH).

To check the Linux kernel parameters for your Linux distribution, see one of the following SAP Notes:

- RHEL6: SAP Note 1496410
- RHEL7: SAP Note 2002167
- SLES 11: SAP Note 1310037
- SLES 12: SAP Note 1984787

To run an SAP system, you must check and, if necessary, modify the Oracle Solaris kernel parameters or resource controls.

- Oracle Solaris 10: SAP Note 724713
- Oracle Solaris 11: SAP Note 1797712

To check the minimum required OS patches, see SAP Note 837670.

Check the relevant SAP Note for required Oracle Solaris patches:

- Sun Solaris 10 on SPARC: SAP Note 832871
- Oracle Solaris 11: SAP Note 1797712
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AIX: National Language Support (NLS)</strong></td>
<td>Make sure that National Language Support (NLS) and corresponding locales are installed.</td>
</tr>
<tr>
<td></td>
<td>You can check this as follows:</td>
</tr>
</tbody>
</table>
|                      | • Enter the following commands to check whether National Language Support (NLS) is installed: `swlist -v | grep -i nls`  
  The output should contain the string NLS-AIX . . .  
  • Enter the following commands to check which locales are available: `locale -a`  
  The following files must be available: `de_DE.iso88591, en_US.iso88591`. |
| **HP-UX: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.                                                                                                                                                                                                                                                                   |
|                      | You can check this as follows:                                                                                                                                                                                                                                                                                                                               |
|                      | • Ensure that the required locales such as the following are available: `de_DE`, `en_US`  
  • Check SAP Note 187864 for information about corrected operating system locales and SAP blended Code Pages.                                                                                                                                                                                                                              |
| **Linux: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.                                                                                                                                                                                                                                                                       |
|                      | You can check this as follows:                                                                                                                                                                                                                                                                                                                               |
|                      | • Ensure that the required locales such as the following are available: `de_DE`, `en_US`  
  • Check SAP Note 187864 for information about corrected operating system locales and SAP blended Code Pages.                                                                                                                                                                                                                              |
| **Oracle Solaris: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.                                                                                                                                                                                                                                                                        |
|                      | Enter the following command to check which locales are available: `locale -a`  
  The following locale must be available: `en_US.ISO8859-1`.                                                                                                                                                                                                                                                                 |
| **System language**  | For the installation, you must choose English as the operating system language on all hosts that run SAP software.                                                                                                                                                                                                                                           |
Table 9: Other Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Minimum Web Browser                  | Make sure that you have at least one of the following web browsers installed on the host where you run the installer GUI:  
  - Microsoft Internet Explorer 11 or higher  
  - Microsoft Edge  
  - Mozilla Firefox  
  - Google Chrome  
  Always use the latest version of these web browsers.  
  You need a web browser to be able to run the SL Common GUI, and to display the Evaluation Form and send it to SAP. |
| AIX: Additional software             | Make sure that the following additional file sets are installed:  
  - bos.adt – Base Application Development  
  - bos.perf – performance and diagnostics tools  
  - perfagent.tools – performance monitoring tools  
  - bos.perf.libperfstat – Performance Statistics Library                                                                                                                                                                           |
| Host name                            | To find out physical host names, open a command prompt and enter `hostname`.  
  For more information about the allowed host name length and characters allowed for SAP system instance hosts, see SAP Note [611361](#).  
  Only valid for 'Platform': HP-UX  
  For HP-UX, see SAP Note [1503149](#) in addition.  
  End of 'Platform': HP-UX  
  If you want to use virtual host names, see SAP Note [962955](#).                                                                                                                                                                        |
| Login shell                          | The installer only prompts you for this parameter if you use a login shell other than the recommended C shell (csh).  
  For more information, see SAP Note [202227](#).  
  Only valid for 'Platform': HP-UX  
  For HP-UX, see SAP Note [1038842](#) in addition.  
  End of 'Platform': HP-UX                                                                                                                                                                                                                    |
| SAP Host Agent installation:        |  
  - Make sure that `/bin/false` can be used as a login shell.  
  - Only valid for 'Platform': AIX  
  - AIX only: Add `/bin/false` to the list of valid login shells (attribute `shells`) in `/etc/security/login.cfg`.  
  - End of 'Platform': AIX                                                                                                                                                                                                                |
| HP-UX: Mount and file system         | configuration  
  For recommendations about block size and mount option configuration, see SAP Note [1077887](#).                                                                                                                                                                |
### Requirement

<table>
<thead>
<tr>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>If application servers are installed decentralized, a “shared” file system must be installed, for example Network File System (NFS).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AIX: C++ Runtime environment</th>
<th>Minimal C++ runtime requirements for the specific SAP Kernel releases are listed in SAP Note 1780629.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux: C compiler</td>
<td>Make sure that the C compiler gcc is installed.</td>
</tr>
</tbody>
</table>

### 2.2 Basic Installation Parameters

The table below lists the basic input parameters that are prompted by the installer. For all other SAP system parameters, use the F1 help in the installer screens.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID (&lt;\text{SAPSID}&gt;)</td>
<td>The SAP System ID (&lt;\text{SAPSID}&gt;) identifies the whole SAP system.</td>
</tr>
</tbody>
</table>

**Caution**

Choose your SAP system ID carefully. You **cannot** change the SAP system ID after the installation.

Make sure that your SAP system ID:
- Is unique throughout your organization
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the reserved IDs listed in SAP Note 1979280.

**Caution**

You must choose an SAP system ID that is different from the SAP system ID of the central instance of the SAP system the Gateway belongs to.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Instance Number for the standalone Gateway** | **Instance Number:**  
Technical identifier for internal processes. Consists of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers.  

Only valid for 'Platform': HP-UX  

⚠️ **Caution**  
Do not use 75 for the instance number of the standalone Gateway because this number is already used by the operating system. For more information, see SAP Note 29972. |

End of 'Platform': HP-UX |
| **Virtual Host Name**            | Virtual host name (network name) of the SAPSID cluster group  
If you provide a virtual host name in the `<Instance_Name> Virtual Host` field of the screen of an instance, this instance is installed with the given virtual host name. After the installation has completed, all application servers can use this virtual host name to connect to the instance. The virtual host name is also a global host name. If you do not provide the virtual host name, the instance is installed automatically using its physical host name.  
You must have already reserved the virtual host name (network name) and its IP address on a DNS server before you run the installer. For more information, see Using Virtual Host Names [page 29].  

⚠️ **Note**  
Fully qualified host names, IPv4, IPv6 are not accepted as virtual host names.  
Alternatively you can assign virtual host names also by starting the installer with the `SAPINST_USE_HOSTNAME` property. For more information, see Running the Installer [page 39]. |
### Parameters | Description
--- | ---
**Operating System Users and Groups** | The installer processes the operating system users as follows:
- If the operating system users do not exist, the installer creates the following users:
  - The SAP system administrator user `<sapsid>adm`
  - Database administrator users
  The installer sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode `Custom` or by changing them on the parameter summary screen.
- If the operating system users already exist, the installer prompts you for the existing password, except if the password of these users is the same as the master password.
- Make sure that the user ID and group ID of these operating system users are unique and the same on each relevant application server instance host.

During the **Define Parameters** phase of the installer you can specify that the `sapinst` group is to be removed from the group set of the operating system users after the execution of the installer has completed.

The `sapinst_instdir` directory belongs to a group named `sapinst`. If this group is not available, it is created automatically as a local group. For security reasons, SAP recommends removing the `sapinst` group from the operating system user groups after the execution of the installer has completed.

For more information about the `sapinst` group, see [Creating Operating System Users and Groups](#page22).
For more information about the `sapinst_instdir` directory, see [Useful Information About the Installer](#page43).

**SAP Host Agent Upgrade (Optional)** | If there already exists an SAP Host Agent on the installation host, the installer asks you if you want to upgrade it to a newer patch level version. If you want the existing version to be upgraded, you must provide the new target version of the `SAPHOSTAGENT<Version>.SAR` archive.

For more information, see [SWPM10SPSupport_Package_Number_Version_Number.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation)](#page32)
3 Preparation

3.1 Creating Operating System Users and Groups

During the installation, the installer checks all required accounts (users, groups) and services on the local machine. The installer checks whether the required users and groups already exist. If not, it creates new users and groups as necessary.

The `sapinst_instdir` directory belongs to a group named `sapinst`. If this group is not available, it is created automatically as a local group.

If you do not want the installer to create operating system users, groups, and services automatically, you can optionally create them before the installation is started. This might be the case if you use central user management such as Network Information System (NIS).

For distributed installations, unless you are using global accounts or NIS, you must create the target users automatically using the installer or manually on the operating system, before starting the installation:

⚠️ Caution

The user ID (UID) and group ID (GID) of SAP users and groups must be identical for all servers belonging to an SAP system.

This does not mean that all users and groups have to be installed on all SAP servers.

Only valid for 'Platform': z/OS


End of 'Platform': z/OS

The installer checks if the required services are available on the host and creates them if necessary. See the log messages about the service entries and adapt the network-wide (NIS) entries accordingly.

The installer checks the NIS users, groups, and services using NIS commands. However, the installer does not change NIS configurations.

➡️ Recommendation

For a distributed or a high-availability system, we recommend that you distribute account information (operating system users and groups) over the network, for example by using Network Information Service (NIS).
If you want to use global accounts that are configured on a separate host, you can do this in one of the following ways:

- You start the installer and choose **Generic Installation Options > Operating System Users and Groups**.
  For more information, see Running the Installer [page 39].
- You create operating system users and groups manually. Check the settings for these operating system users.

### User Settings

- **Oracle Solaris**: If your operating system is Oracle Solaris 10 or higher, follow the parameter recommendations for SAP applications in SAP Note 724713.

**End of ‘Platform’: Oracle Solaris**

- **AIX**: Make sure that you have set the limits for operating system users as described in SAP Note 323816.

**End of ‘Platform’: AIX**

- **HP-UX, Linux, Oracle Solaris**: Make sure that you have set the limits for operating system users root, `<sapsid>`adm, and your database-specific operating system users (see also section “Creating Operating System Users and Groups” and “Running the Installer” in the installation guide).

**Caution**

Caution: the `limit` mechanism supports hard and soft limits. The soft limit cannot be bigger than the hard limit. The hard limit can be set/increased by the root user like: `limit -h <limit> <new_value>`, for example `limit -h datasize unlimited`.

- Using `csh` shell, the output of command `limit` needs to be at least as follows:

**Example**

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cputime</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>unlimited</td>
</tr>
<tr>
<td>datasize</td>
<td>unlimited</td>
</tr>
<tr>
<td>stacksize</td>
<td>8192 KB</td>
</tr>
</tbody>
</table>
Using `sh` or `ksh` shell, the output of command `ulimit -a` needs to be at least as follows:

**Example**

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

<table>
<thead>
<tr>
<th>Output sh</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>coredumpsize</td>
<td>unlimited</td>
</tr>
<tr>
<td>descriptors</td>
<td>8192</td>
</tr>
<tr>
<td>memoryuse</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output ksh</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu time (seconds)</td>
<td>unlimited</td>
</tr>
<tr>
<td>file size (blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>data seg size (kbytes)</td>
<td>unlimited</td>
</tr>
<tr>
<td>stack size (kbytes)</td>
<td>8192 KB</td>
</tr>
<tr>
<td>core file size (blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>open files</td>
<td>nofile</td>
</tr>
<tr>
<td>max memory size (kbytes)</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

---

- All users **must** have identical environment settings. Any change to the environment – such as variables, or paths – is at your own responsibility.
- The `sapinst_instdir` directory belongs to a group named `sapinst`. If this group is not available, it is created automatically as a local group. For security reasons, SAP recommends you to remove the sapinst group from the operating system user groups after the execution of the installer has completed.
- If you have multiple operating system users with user ID (UID) 0, you must assign the `sapinst` group to all of them.
- Do **not** delete any shell initialization scripts in the home directory of the operating system users. This applies even if you do not intend to use the shells that these scripts are for.
- If you create operating system users manually or use already existing operating system users, make sure that the home directory for each of these users is **not** the root directory (`/`).
- Make sure that the home directory of user `<sapsid>adm` is not critical for recursive changes on permissions.

When operating system users are created by the installer, the permissions on the home directories of these users are changed recursively. This can cause unpredictable errors if you define a critical home directory.
For example, the home directory must **not** be `/` or `/usr/sap`.

- **Only valid for 'Platform': HP-UX**

  **HP-UX:** To prevent terminal query errors in the `<sapsid>adm` environment, comment out the line `eval 'tset -s ~Q -m ':?hp'` in the `/etc/skel/.login` script. For more information, see SAP Note 1038842.

  End of 'Platform': HP-UX

---

### Operating System Users and Groups

The installer chooses available operating system user IDs and group IDs.

If you have multiple operating system users with user ID (UID) 0, you must assign the `sapinst` group to all of them.

**Recommendation**

For security reasons, we recommend that you remove the operating system users from the group `sapinst` **after** the installer has completed.

We recommend that you specify this “cleanup” already during the Define Parameters phase on the Cleanup Operating System Users screen. Then, the removal of the operating system users from the group `sapinst` is done automatically.

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Groups</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>root</td>
<td></td>
<td>sapinst</td>
<td>Superuser of the UNIX Operating system</td>
</tr>
<tr>
<td><code>&lt;sapsid&gt;adm</code></td>
<td>sapsys</td>
<td>sapinst</td>
<td>SAP system administrator</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td><code>&lt;sapsid&gt;adm</code></td>
</tr>
<tr>
<td>sapinst</td>
<td><code>root, &lt;sapsid&gt;adm</code></td>
</tr>
</tbody>
</table>

### 3.2 SAP Directories

The installer automatically creates the directories listed in the following figures and tables. Before running the installation, you have to set up the required file systems manually. In addition, you have to make sure that the required disk space for the directories to be installed is available on the relevant hard disks. The figure below assumes that you have set up one file system for the SAP system mount directory `<sapmnt>` and one file
system for the /usr/sap directory. However, you have to decide for which directories you want to set up separate file systems. If you do not set up any file system on your installation host, the installer creates all directories in the root directory /. The installer prompts you only for the <sapmnt> directory during the installation.

Figure 1: SAP Directories of a Standalone Gateway for SAP Systems based on SAP NetWeaver 7.0 to SAP NetWeaver 7.0 EHP3
The directory of the Gateway instance is $G<\text{Instance\_Number}>$, for example G00.

**SAP Directories in Detail**

**Note**

The listed file system sizes are initial SAP requirements.

Depending on your operating system, you might also have to add space for administrative purposes.
Table 15:

<table>
<thead>
<tr>
<th>File System Name</th>
<th>Description</th>
<th>Space Required</th>
</tr>
</thead>
</table>
| `/<sapmnt>/<SAPSID>` | The default name for the SAP system mount directory is `sapmnt`.  
  - `exe`  
    Contains executable kernel programs  
  - `global`  
    Contains log files  
  - `profile`  
    Contains the start and operations profiles of the Gateway instance | 500 MB |
| `/usr/sap/<SAPSID>` | This directory contains the following subdirectories:  
  - `SYS`  
  - `<INSTANCE>`  
    The instance name (instance ID) of the Gateway instance is `G<Instance_Number>`, for example `G00`.  
    There are subdirectories of `/usr/sap/<SAPSID>/SYS` with symbolic links to subdirectories of `/<sapmnt>/<SAPSID>`: | 500 MB |
| `/usr/sap/trans` | This directory contains SAP software for the transport of objects between SAP systems. | This value heavily depends on the use of your SAP system.  
For the installation, it is sufficient to use 200 MB. You can enlarge the file system afterwards if required. |
3.3 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

Context

Procedure

Proceed as described in SAP Note 962955.

3.4 Preparing the Installation Media

This section describes how to prepare the installation media.

Installation media are available as follows:

- The Software Provisioning Manager 1.0 archive containing the installer
  You always have to download the latest version of the Software Provisioning Manager 1.0 archive.
- The complete media or dedicated installation archives (SAR files) containing the software to be installed, which are available as follows:
  - You can use the physical installation media as part of the installation package as described in Using the Physical Media from the Installation Package [page 33].
  - You download the complete installation media as described in Downloading Complete Installation Media [page 34].
  - As an alternative to downloading the complete SAP kernel media, you can download the specific SAP kernel archives (SAR files), as described in SWPM10SPSupport_Package_Number_Version_Number.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation) [page 32].
The content of this section is not applicable if you use 70SWPM10SP<Support_Package_Number>_<Version_Number>.SAR for running the installer.

The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060.

For more information about which kernel version to use, see SAP Note 1680045. In addition, check the Product Availability Matrix at: http://support.sap.com/pam.

Related Information

Downloading and Extracting the Software Provisioning Manager Archive [page 30]
Downloading Complete Installation Media [page 34]
Using the Physical Media from the Installation Package [page 33]
SWPM10SPSupport_Package_Number_Version_Number.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation) [page 32]

3.4.1 Downloading and Extracting the Software Provisioning Manager Archive

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive [70]SWPM10SP<Support_Package_Number>_<Version_Number>.SAR from:
   https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES By Alphabetical Index (A-Z) S SOFTWARE PROVISIONING MANAGER

2. Get the latest version of the sapcar tool on the host where you want to run the installer:
   a. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES and search for “sapcar”.
   b. Select the archive file for your operating system and download it to an empty directory.
c. Rename the executable to `sapcar.exe`.
   For more information about `SAPCAR`, see SAP Note 212876.

3. Using the latest version of `SAPCAR`, you can verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive as follows:
   a. Get the latest version of the `SAPCRYPTOLIB` archive to your installation host as follows:
      1. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES and search for “sapcryptolib”.
      2. Select the archive file for your operating system and download it to the same directory where you have put the `SAPCAR` executable.
      3. Use the following command to extract the `SAPCRYPTOLIB` archive to the same directory where you have put the `SAPCAR` executable:
         ```bash
         sapcar -xvf sapcryptolibp_84.sar -R <target directory>
         ```
      4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/crlbag.p7s and move it into the same directory.
   b. Verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive by executing the following command:
      ```bash
      /<Path to SAPCAR>/sapcar -tvVf <Path to Download Directory>/ [70]SWPM10SP<Support_Package_Number>_<Version_Number>.SAR -crl <file name of revocation list>
      ```
   4. Unpack the Software Provisioning Manager archive to a local directory using the following command:
      ```bash
      /<Path to SAPCAR>/sapcar -xvf <Path to Download Directory>/ [70]SWPM10SP<Support_Package_Number>_<Version_Number>.SAR <Path to Unpack Directory>
      ```
      Note: Check SAP Notes 2178665 and 1680045 whether additional information is available.
      i  Note
      Make sure that all users have read permissions for the directory where you want to unpack the installer.
      i  Note
      Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.
3.4.2 SWPM10SP<Support_Package_Number>_<Version_Number>.SAR Only: Downloading SAP Kernel Archives (Archive-Based Installation)

As an alternative to downloading the complete SAP Kernel media, you can also download exactly the installation archives that are required for your installation.

**Note**
The content of this section is not applicable if you use 70SWPM10SP<Support_Package_Number>_<Version_Number>.SAR for running the installer.

**Context**

You must download - apart from the Software Provisioning Manager 1.0 archive which is always required for an installation - the SAPEXE <Version>.SAR and SAPHOSTAGENT<Version>.SAR archive files.

**Note**
The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host Agent available on the installation host or you specified during the Define Parameters phase that you want to upgrade an existing version of the SAP Host Agent already available on the installation host. In the latter case, you must specify a higher version of the SAPHOSTAGENT<Version>.SAR. Otherwise the existing SAP Host Agent is not upgraded.

During the installation, you can either specify the path to each archive separately, or provide the path to a download basket with all downloaded archives.

**Caution**
- Make sure that you always use the highest available patch level unless special patch levels are specified for the relevant package in SAP Note 1680045.
- Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the same SAP kernel release and extension:

**Example**
- If SAPEXE<Version>.SAR is of version 7.42 EXT, then SAPEXEDB<Version>.SAR must also be of version 7.42 EXT.
- If SAPEXE<Version>.SAR is of version 7.45, then SAPEXEDB<Version>.SAR must also be of version 7.45.

- If you provide the archives in one download folder, and there is more than one version of the same archive available - for example SAPEXE<Version>.SAR - and these versions match the product-specific requirements, the installer selects one of these archive versions. If you want a specific archive version to be used, make sure that this is the only version available in the download folder. When running system provisioning in GUI mode, you can also check in the GUI which archive is being used. So
even if there is more than one version of the same archive available in the download folder, you can select the exact archive version you want to use and enter the exact path to the required archive file.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 30].

2. Go to http://support.sap.com/swdc

3. Download the latest patch level of the following software component archives (*.SAR files) from the following paths:
   - SAPEXE <Version>.SAR: from the following path:
     Additional Components SAP Kernel SAP KERNEL 64-BIT <SAP KERNEL <7.21 or Higher> 64-BIT> <Operating System> #DATABASE INDEPENDENT
   - SAPHOSTAGENT <Version>.SAR:
     SAP Technology Components SAP HOST AGENT SAP HOST AGENT 7.21 <Operating System>

Note

The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host Agent available on the installation host or you specified during the Define Parameters phase that you want to upgrade an existing version of the SAP Host Agent already available on the installation host. In the latter case, you must specify a higher version of the SAPHOSTAGENT<Version>.SAR. Otherwise the existing SAP Host Agent is not upgraded.

3.4.3 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

Procedure

1. Identify the required media for your installation as listed below.

   Table 16:

<table>
<thead>
<tr>
<th>Installation Media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Provisioning Manager 1.0</td>
<td>Software provisioning manager 1.0 archive</td>
</tr>
<tr>
<td></td>
<td>SWPM10SP&lt;Support_Package_Number&gt;_&lt;Version_Number&gt;.SAR</td>
</tr>
</tbody>
</table>

Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on UNIX
Preparation
<table>
<thead>
<tr>
<th>Installation Media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Kernel</td>
<td>Non-Unicode (NUC) Kernel (folder \texttt{K_&lt;Version&gt;<em>N</em>&lt;OS&gt;}) where \texttt{N} means non-Unicode.</td>
</tr>
</tbody>
</table>

2. Make the installation media available on the installation host as follows:
   a. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 30].
   b. Make the media containing the software to be installed available.
      You can do this in one of the following ways:
      - Copy the required media folders directly to the installation host.
      - Mount the media on a central media server that can be accessed from the installation hosts.

\begin{warning}
\textbf{Caution}

If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.
\end{warning}

### 3.4.4 Downloading Complete Installation Media

This section describes how you download media from the SAP Software Download Center.

**Procedure**

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 30].
2. Identify all download objects that belong to one medium according to one of the following:
   - Download path or location:
     - To download the complete kernel media, go to https://support.sap.com/sitoolset\textgreater System Provisioning \textgreater Software Provisioning Manager 1.0 SP<Current Version> \textgreater Download Kernel releases delivered for SL Toolset \textgreater SL TOOLSET 1.0 (INSTALLATIONS AND UPGRADES) \textgreater KERNEL FOR INSTALLATION/SWPM \textgreater
To download all media required for your SAP product, you can use one of the following navigation paths:

- [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) ➔ INSTALLATIONS & UPGRADES ➔By Category ➔ SAP NETWEAVER AND COMPLEMENTARY PRODUCTS ➔ <Product> ➔ <Product Release>


- Material number
  All download objects that are part of an installation medium have the same material number and an individual sequence number:
  <Material_Number>_<Sequence_Number>

- Example
  51031387_1
  51031387_2
  ...

- Title
  All objects that are part of an installation medium have the same title, such as
  <Solution><Media_Name><OS> or <Database>RDBMS<OS> for database media.

3. Download the objects to the download directory.

4. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.
   In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note [1258173](https://support.sap.com/).

**Caution**

Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for archive-based installation.
4 Installation

4.1 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

- If you want to use the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11. Always use the latest version of these web browsers.
  - Recommendation: We recommend using Google Chrome.
  - If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the SL Common GUI.
  
  For more information about the SL Common GUI, see Useful Information About the Installer [page 43].

- We recommend that you use the csh shell for the installation. If you want to use another shell, make sure that you have read SAP Note 202227.

  The installer uses csh scripts during the installation to obtain the environment for user <sapsid>adm.

  This is also true if user <sapsid>adm already exists from an earlier SAP system installation, and the shell of this user is not csh. Before you start the installer, execute the following command as user <sapsid>adm to make sure that the csh scripts are up-to-date:

  `/bin/csh -c "source /home/<sapsid>/adm/.cshrc;env"

- Make sure that your operating system does not delete the contents of the temporary directory /tmp or the contents of the directories to which the variables TEMP, TMP, or TMPDIR point, for example by using a crontab entry.

  Make sure that the temporary directory has the permissions 777.

- Make sure that you have at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the installer executables. If you cannot provide 300 MB free space in the temporary directory, you can set one of the environment variables TEMP, TMP, or TMPDIR to another directory with 300 MB free space for the installer executables.

  You can set values for the TEMP, TMP, or TMPDIR environment variable to an alternative installation directory as described in section Useful Information About the Installer [page 43].

- The following information is only valid if you use the Java GUI:

  Make sure that your DISPLAY environment variable is set to <Host_Name>:0.0, where <Host_Name> is the host on which you want to display the installer GUI.
You can set values for the DISPLAY environment variables as follows:

Table 17:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td>DISPLAY=&lt;Host_Name&gt;:0.0</td>
</tr>
<tr>
<td></td>
<td>export DISPLAY</td>
</tr>
<tr>
<td>C shell (csh)</td>
<td>setenv DISPLAY &lt;Host_Name&gt;:0.0</td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td>export DISPLAY=&lt;Host_Name&gt;:0.0</td>
</tr>
</tbody>
</table>

- Make sure that umask is set to 022 for the user with root permissions that you want to use for running the installer.
  As the user with root permissions that you want to use for running the installer, enter the following command: umask 022

- Only valid for 'Platform': AIX
  AIX: Make sure that you have set the limits for operating system users as described in SAP Note 323816

- Only valid for 'Platform': HP-UX, Linux, Oracle Solaris
  HP-UX, Linux, Oracle-Solaris: Make sure that you have set the limits for operating system users root, <sapsid>adm, and your database-specific operating system users (see also section "Creating Operating System Users and Groups" and "Running the Installer" in the installation guide).

Caution

Caution: the limit mechanism supports hard- and soft-limits. The soft-limit cannot be bigger than the hard-limit. The hard-limit can be set/increased by the root user like: limit -h <limit> <new_value>, for example limit -h datasize unlimited.

- Using csh shell, the output of command limit needs to be at least as follows:

Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

Table 18:

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cputime</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>unlimited</td>
</tr>
<tr>
<td>datasize</td>
<td>unlimited</td>
</tr>
<tr>
<td>stacksize</td>
<td>8192 KB</td>
</tr>
<tr>
<td>coredumpsize</td>
<td>unlimited</td>
</tr>
</tbody>
</table>
Using `sh` or `ksh` shell, the output of command `ulimit -a` needs to be at least as follows:

### Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

**Table 19:**

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>descriptors</td>
<td>8192</td>
</tr>
<tr>
<td>memoryuse</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

- Make sure that you have defined the most important SAP system parameters as described in **Basic Installation Parameters** [page 19] before you start the installation.
- Make sure that the following ports are not used by other processes:
  - When using the SL Common GUI:
    - Port 4237 is used by default as HTTPS port for communication between the installer and the SL Common GUI.
    - If this port cannot be used, you can assign a free port number by executing `sapinst` with the following command line parameter:
      ```
      SAPINST_HTTPS_PORT=<Free Port Number>
      ```
    - Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
    - The filled-out evaluation form is then sent to SAP using HTTPS.
    - If this port cannot be used, you can assign a free port number by executing `sapinst` with the following command line parameter:
      ```
      SAPINST_HTTP_PORT=<Free Port Number>
      ```
  - When using the Java SDT GUI:
    - Port 21212 is used by default for communication between the installer GUI server and the installer GUI client.
If this port cannot be used, you can assign a free port number by executing `sapinst` with the following command line parameter:

```
SAPINST_DIALOG_PORT=<Free Port Number>
```

- Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing. The filled-out evaluation form is then sent to SAP using HTTPS.

If this port cannot be used, you can assign a free port number by executing `sapinst` with the following command line parameter:

```
SAPINST_HTTP_PORT=<Free Port Number>
```

## 4.2 Running the Installer

This section describes how to run the installation tool Software Provisioning Manager 1.0 (the “installer” for short).

### Prerequisites

For more information, see Prerequisites for Running the Installer [page 36].

### Context

Software Provisioning Manager (the “installer” for short) offers two GUIs:

- The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
- The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

**Note**

If the SL Common GUI does not meet your requirements you can still use the “classic” Java SDT GUI. You then have to start the `sapinst` executable with the command line option

```
SAPINST_SLP_MODE=false
```

In cases where both GUIs behave the same way, we address them as “installer GUI”.

For more information, see Useful Information About the Installer [page 43].

This procedure describes an installation where you use one of the following GUI scenarios:

- You run the installer and use the SL Common GUI. Then you can control the processing of the installer in the browser running on any device.
- You run the installer and use the Java SDT GUI. Both are running on the same host.
The following information is only valid if you use the Java SDT GUI:

- If you need to see the installation on a remote display, we recommend that you perform a remote installation [page 48], where the installer GUI is running on a separate host from the installer.
- Alternatively you can use an X server for Microsoft Windows or other remote desktop tools for remote access to the installer GUI on Windows workstations. For more information, see SAP Note 1170809.

Procedure

1. Log on to the installation host as a user with root permissions.
   
   **Caution**
   Make sure that the user with root permissions that you want to use for running the installer has not set any environment variables for a different SAP system or database.

   **SL Common GUI only:** If your security policy requires that the person running the installer is not allowed to know the credentials of a user with root permissions on the installation host, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting the sapinst executable from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

2. Make the installation media available.
   
   For more information, see Preparing the Installation Media [page 29].
   
   **Recommendation**
   Make the installation media available locally. For example, if you use Network File System (NFS), reading from media mounted with NFS might fail.

   **Note**
   Oracle Solaris: If you mount installation media, make sure that you do this with option nomapcase.

3. Start the installer from the directory to which you unpacked the Software Provisioning Manager archive by entering the following commands:

   ```
   <Path_To_Unpack_Directory>/sapinst
   ```

   **Note**
   If you need to assign a virtual host name to the instance to be installed and you do not want to assign it by entering it as a parameter using the installer screens (see Basic Installation Parameters [page 19]), you can alternatively assign it by starting the installer with the SAPINST_USE_HOSTNAME property:

   ```
   <Path_To_Unpack_Directory>/sapinst SAPINST_USE_HOSTNAME=<Virtual_Host_Name>
   ```
For more information, see Using Virtual Host Names [page 29].

4. The installer is starting up.

Depending on the type of the installer GUI you want to use, do one of the following:

○ If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you are running the installer.

Sample Code

```...```
```shell
Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]
```

```...
```

If you have a supported web browser (see Prerequisites for Running the Installer [page 36]) installed on the host where you run the installer, you can open this URL directly in the shell. Otherwise open the URL in a supported web browser that runs on another device. The SL Common GUI opens in the browser by displaying the Welcome screen.

Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

○ If you use the Java SDT GUI - that is you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the Welcome screen.

5. On the Welcome screen, choose the required option:

○ If you are using the 70SWPM*.SAR:

  ○ To install a new standalone Gateway instance, choose `Gateway`.

  ○ To rename an existing standalone Gateway instance, go to System Rename and choose:

    `Distributed System > System Rename for Gateway Instance`.

  ○ To uninstall an existing standalone Gateway instance, go to `Options > Uninstall` and choose: `Uninstall - Systems / Standalone Engine / Optional Standalone Unit`.

○ If you are using the SWPM*.SAR:

  ○ To install a new standalone Gateway instance, choose `Standalone Engines`.

  ○ To rename an existing standalone Gateway instance, go to `System Rename` and choose:

    `Distributed System > System Rename for Gateway Instance`.

Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on UNIX
To uninstall an existing standalone Gateway instance, go to Generic Options > Database > Uninstall and choose: Uninstall - SAP Systems or Single Instances.

6. Choose Next.

7. Follow the instructions on the installer screens and enter the required parameters.

**Note**

To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field:

- If you use the SL Common GUI, choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.
- If you use the Java SDT GUI, choose F1. Then a dialog opens with the available help text.

**Caution**

The signature of media is checked automatically during the Define Parameters phase while processing the Media Browser screens.

Keep in mind that this automatic check is only committed once and not repeated if you modify artefacts such as SAR archives or files on the media after the initial check has been done - that is if you modify artefacts later on either during the remaining Define Parameters phase or later on during the Execute Service phase the signature is not checked again.

See also the description of this new security feature in SAP Note 2393060.

After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

8. To start the installation, choose Next.

The installer starts the installation and displays the progress of the installation. When the installation has finished, the installer shows the message: Execution of <Option_Name> has completed.

**Caution**

**HP-UX only:** If you decided to use 02 as the instance number, the instance fails to start during the installation process. For more information about the cause, see Basic Installation Parameters [page 19]. You have to manually change the port number for report RSLGCOLL to continue with the installation.

Proceed as follows:

1. Go to directory /<sapmnt>/<SAPSID>/profile.
2. Edit DEFAULT.PFL.
3. Set the parameter rslg/collect_daemon/listen_port to a free port number.

**End of 'Platform': HP-UX**

9. If required, delete directories with the name sapinst_exe.xxxxxx.xxxx after the installer has finished. Sometimes these directories remain in the temporary directory.
10. **Java GUI only:** For security reasons, we recommend that you delete the `.sdtgui` directory within the home directory of the user with which you ran the installer:

   `<User_Home>/sdtgui/`

11. If you copied the installer software to your hard disk, you can delete these files when the installation has successfully completed.

12. For security reasons, we recommend that you remove the operating system users from the group `sapinst` after you have completed the installation.

   **Note**
   
   This step is only required, if you did **not** specify during the *Define Parameters* phase that the operating system users are to be removed from the group `sapinst` after the execution of the installer has completed.

### 4.3 Additional Information About the Installer

The following sections provide additional information about the installer.

#### Related Information

- Useful Information About the Installer [page 43]
- Interrupted Processing of the Installer [page 45]
- Performing a Remote Installation (Java SDT GUI only) [page 48]
- Starting the Java SDT GUI Separately [page 50]
- Running the Installer in Accessibility Mode [page 52]
- Troubleshooting with the Installer [page 54]

#### 4.3.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- Software Provisioning Manager (the installer) offers two GUIs:
  - The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
○ The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short
The SL Common GUI of the Software Provisioning Manager (or “SL Common GUI” for short) uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:
○ Zero foot print, since only a web browser is required on the client
○ New controls and functionality, for example, view logs in web browser.
The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.
For the SL Common GUI the installer provides a pre-generated URL at the bottom of the shell from which you are running the installer . If you have a supported web browser installed on the host where you run the installer, you can start the SL Common GUI directly from this URL. Otherwise, open a web browser supported by the SL Common GUI on any device and run the URL from there.
For more information about supported web browsers see Prerequisites for Running the Installer [page 36].
If the SL Common GUI does not meet your requirements, you can still use the “classic” Java SDT GUI. To do so, you must start the sapinst executable with the command line option SAPINST_SLP_MODE=false. You can switch back to the default installer GUI at any time with the following steps:
1. Stop the installer.
2. Restart the installer with command line option SAPINST_SLP_MODE=false.
3. On the What do you want to do? screen choose Continue with the existing run.
• The installer creates the installation directory sapinst_instdir directly below the temporary directory. The installer finds the temporary directory by checking the value of the TEMP, TMP, or TMPDIR environment variable. If no value is set for these variables, the installer uses /tmp as default installation directory.
If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR to the required directory before you start the installer.
Table 20:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td>TEMP=&lt;Directory&gt; export TEMP</td>
</tr>
<tr>
<td>C shell (csh)</td>
<td>setenv TEMP &lt;Directory&gt;</td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td>export TEMP=&lt;Directory&gt;</td>
</tr>
</tbody>
</table>

⚠️ Caution

Make sure that the installation directory is not mounted with NFS, otherwise there might be problems when the Java Virtual Machine is started.

• For each option, the installer creates a subdirectory located in the sapinst_instdir directory.
• The installer extracts itself to the temporary directory. These executables are deleted again after the installer has stopped running.
Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them.
The temporary directory also contains the log file `dev_selfex.out` from the extraction process, which might be useful if an error occurs.

⚠️ Caution

If the installer cannot find a temporary directory, the installation terminates with the error `FCO-00058`.

- To see a list of all available installer properties, start the installer as described above with the option `-p`:
  ```
  ./sapinst -p
  ```
- **This information is only relevant if you use the Java GUI of the installer:** If you need to run the installer in accessibility mode, proceed as described in Running the Installer in Accessibility Mode [page 52].
- If you want to install an SAP system in unattended mode, see SAP Note 2230669 which describes an improved procedure using `inifile.params`.
- If required, stop the installer by choosing one of the following, depending on the installer GUI you use:
  - In the SL Common GUI, choose the **Cancel** button.
  - In the Java SDT GUI, choose **SAPinst Exit Process** in the Java SDT GUI menu.

ℹ️ Note

If you need to terminate the installer, press `Ctrl` + `C`.

---

### 4.3.2 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

**Context**

The processing of the installer might be interrupted for one of the following reasons:

- An error occurred during the **Define Parameters** or **Execute** phase:
  The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- You interrupted the installation by choosing
  - **Cancel** in the SL Common GUI
  - **Exit Process** in the **SAPinst** menu in the Java SDT GUI

⚠️ Caution

If you stop an option in the **Execute** phase, any system or component **installed** by this option is incomplete and not ready to be used. Any system or component **uninstalled** by this option is not completely uninstalled.
The following table describes the options in the dialog box:

Table 21:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>The installer retries the installation from the point of failure without repeating any of the previous steps. This is possible because the installer records the installation progress in the <code>keydb.xml</code> file. We recommend that you view the entries in the log files, try to solve the problem, and then choose <em>Retry</em>. If the same or a different error occurs, the installer displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server. The installer records the installation progress in the <code>keydb.xml</code> file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>The installer continues the installation from the current point.</td>
</tr>
<tr>
<td><strong>View Log</strong></td>
<td>Access installation log files.</td>
</tr>
</tbody>
</table>

**Note**

You can also terminate the installer by choosing `Ctrl + C` but we do not recommend this because it kills the process immediately.

The following procedure describes the steps to restart an installation, which you stopped by choosing *Stop*, or to continue an interrupted installation after an error situation.

**Procedure**

1. Log on to the installation host as a user with the required permissions as described in *Running the Installer* [page 39].
2. Make sure that the installation media are still available.
   For more information, see *Preparing the Installation Media* [page 29].

**Recommendation**

Make the installation media available **locally**. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.
3. Restart the installer from the directory to which you unpacked the Software Provisioning Manager archive by executing the following command:

```
<Path_To_Unpack_Directory>/sapinst
```

4. The installer is restarting.

Depending on the type of the installer GUI you want to use, do one of the following:

○ If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI.

You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you are running the installer.

```markdown
---
Sample Code
---

Open your browser and paste the following URL address to access the GUI

https://[<hostname>]:4237/sapinst/docs/index.html

Logon users: [<users>]

---

If you have a supported web browser (see Prerequisites for Running the Installer [page 36]) installed on the host where you run the installer, you can open this URL directly in the shell. Otherwise open the URL in a supported web browser that runs on another device.

The SL Common GUI opens in the browser by displaying the Welcome screen.

i Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

○ If you use the Java SDT GUI - that is you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the Welcome screen.

5. From the tree structure on the Welcome screen, select the installation option that you want to continue and choose Next.

The What do you want to do? screen appears.

6. On the What do you want to do? screen, decide between the following alternatives and continue with Next:
Table 22:

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform a new run</td>
<td>The installer does not continue the interrupted installation option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: <code>log_&lt;Day&gt;_&lt;_Month&gt;_&lt;_Year&gt;_&lt;_Hours&gt;_&lt;_Minutes&gt;_&lt;_Seconds&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td><code>log_01_Oct_2016_13_47_56</code></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>All actions taken by the installation before you stopped it (such as creating directories or users) are not revoked.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
</tr>
<tr>
<td></td>
<td>The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.</td>
</tr>
<tr>
<td>Continue with the existing one</td>
<td>The installer continues the interrupted installation from the point of failure.</td>
</tr>
</tbody>
</table>

4.3.3 Performing a Remote Installation (Java SDT GUI only)

Here you find information about how to install your SAP system on a remote host.

**Note**

This section is only valid if you use the Java SDT GUI. That is, you started the `sapinst` executable with command line option `SAPINST_SLP_MODE=false`.

Prerequisites

- The remote host meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 36].
- Both computers are in the same network and can ping each other.
To test this:

1. Log on to your remote host and enter the command: `ping <Local_Host>`
2. Log on to the local host and enter the command: `ping <Remote_Host>`

- If you need to specify another operating system user with the `SAPINST_REMOTE_ACCESS_USER` command line parameter, make sure that this user exists on the remote host.

**Context**

You use this procedure to install your SAP system on a remote host. In this case, the installer runs on the remote host, and the installer GUI runs on the local host. The local host is the host from which you control the installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the local host is not allowed to know the credentials of a user with root permissions on the remote host, you can specify another operating system user for authentication purposes. You do this using the `SAPINST_REMOTE_ACCESS_USER` parameter when starting the `sapinst` executable from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

Alternatively you can use an X server for Microsoft Windows or other remote desktop tools for remote access to the installer GUI on Windows workstations. For more information, see SAP Note 1170809.

**Procedure**

1. Log on to the remote host as a user with root permissions.

   **Caution**

   Make sure that this user has not set any environment variables for a different SAP system or database.

2. Make the installation media available on your remote host.

   For more information, see Preparing the Installation Media [page 29].

   **Recommendation**

   Make the installation media available locally. For example, if you use Network File System (NFS), reading from media mounted with NFS might fail.

   **Note**

   Oracle Solaris: If you mount installation media, make sure that you do this with option `nomapcase`.

3. Open a command prompt and change to the directory to which you unpacked the Software Provisioning Manager archive.
4. Check the version of the sapinst executable by entering the following command:

```bash
<Path_to_Unpack_Directory>/sapinst -sfxver
```

The version of the sapinst executable must be exactly the same as the version of the sapinstgui executable on the local host (see also Starting the Installer GUI Separately [page 50]).

5. Start the installer by entering the following command:

```bash
<Path_to_Unpack_Directory>/sapinst
```

**Note**

If you need to specify another operating system user for authentication purposes, enter the following command:

```bash
<Path_to_Unpack_Directory>/sapinst
SAPINST_REMOTE_ACCESS_USER=<Specified_OS_User>
```

**Note**

If you need to assign a virtual host name to the instance to be installed and you do not want to assign it by entering it as a parameter using the installer screens (see Basic Installation Parameters [page 19]), you can alternatively assign it by starting the installer with the SAPINST_USE_HOSTNAME property:

```bash
<Path_to_Unpack_Directory>/sapinst SAPINST_USE_HOSTNAME=<Virtual_Host_Name>
```

For more information, see Using Virtual Host Names [page 29].

The installer now starts and waits for the connection to the installer GUI. You see the following at the command prompt:

```bash
guiengine: no GUI connected; waiting for a connection on host <Host_Name>, port <Port_Number> to continue with the installation
```

6. Start the installer GUI on your local host as described in Starting the Installer GUI Separately [page 50].

### 4.3.4 Starting the Java SDT GUI Separately

Here you find information about how to start the Java SDT GUI separately.

**Note**

This section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`.

### Prerequisites

The host on which you want to start the installer GUI meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 36].
If you want to run the installer on a Windows host, make sure that you meet the prerequisites for the installer listed in the relevant Windows guide.

**Context**

You might need to start the installer GUI separately in the following cases:

- You closed the installer GUI using `File > Close GUI only` from the installer menu while the installer is still running.
- You want to perform a remote installation, where the installer GUI runs on a different host from the installer. For more information, see Performing a Remote Installation (Java SDT GUI only) [page 48].
- You want to run the installer in accessibility mode. In this case, you have to start the installer GUI separately on a Windows host as described below with the command line parameter `-accessible`. For more information, see Running the Installer in Accessibility Mode [page 52].

In this procedure, the following variables are used: `<Remote_Host>` is the name of the remote host, and `<Port_Number_Gui_Server_To_Gui_Client>` is the port the GUI server uses to communicate with the GUI client (21212 by default).

**Procedure**

- **Starting the Installer GUI on Windows**
  a. Make the installer software available on the host on which you want to start the installer GUI.
  b. Start the installer GUI by executing the `sapinstgui` executable with the appropriate command line parameters:
     1. If you want to perform a remote installation, proceed as follows:
        1. Check the version of `sapinstgui.exe` by entering the following command:
           ```cmd
           <Path_To_Unpack_Directory>\sapinstgui.exe -sfxver
           ```
           The version of the `sapinstgui` executable must be exactly the same as the version of the `sapinst` executable on the remote host (see also Performing a Remote Installation [page 48]).
        2. Start the installer GUI by entering the following command:
           ```cmd
           <Path_To_Unpack_Directory>\sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
           ```
     2. If you closed the installer GUI using `File > Close GUI only` and want to reconnect to the installer, proceed as follows:
        1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
           ```cmd
           <Path_To_Unpack_Directory>\sapinstgui.exe -port <Port_Number_Gui_Server_To_Gui_Client>
           ```
2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
   ```
   <Path_To_Unpack_Directory>/sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
   ```
   c. The installer GUI starts and connects to the installer.

- **Starting the Installer GUI on UNIX**
  a. Make the installer software available on the host on which you want to start the installer GUI.
  b. Start the installer GUI by executing the `sapinstgui` executable with the appropriate command line parameters:
     - If you want to perform a remote installation, proceed as follows:
       1. Check the version of the `sapinstgui` executable by entering the following command:
          ```
          <Path_To_Unpack_Directory>/sapinstgui -sfxver
          ```
          The version of the `sapinstgui` executable must be exactly the same as the version of the `sapinst` executable on the remote host (see also Performing a Remote Installation [page 48]).
       2. Start the installer GUI by entering the following command:
          ```
          <Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
          ```
     - If you closed the installer GUI using `File > Close GUI only` and want to reconnect to the installer, proceed as follows:
       1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
          ```
          <Path_To_Unpack_Directory>/sapinstgui -port <Port_Number_Gui_Server_To_Gui_Client>
          ```
       2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
          ```
          <Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
          ```
   c. The installer GUI starts and connects to the installer.

### 4.3.5 Running the Installer in Accessibility Mode

You can also run the installer in accessibility mode.

**Note**

The information contained in this section is only valid if you use the Java SDT GUI. That is, you started the `sapinst` executable with command line option `SAPINST_SLP_MODE=false`.

If you use the SL Common GUI, apply the standard accessibility functions of your web browser.
Context

The following features are available:

- **Keyboard access:**
  This feature is generally available for all operating systems.

- **High-contrast color:**
  This feature is derived from the Windows display properties. Therefore, to enable this feature, perform a remote installation with the installer GUI running on a Windows host.

- **Custom font setting:**
  This feature is derived from the Windows display properties. Therefore, to enable this feature, perform a remote installation with the installer GUI running on a Windows host.

Procedure

- **Activating and Adjusting Accessibility Settings on Windows**
  You first have to activate and adjust the relevant settings for the font size and color schemes before you start the installer or the installer GUI.

  **Note**
  The following procedure applies for Windows Server 2012 and might be different when using another Windows operating system.

  a. Right click on your Windows desktop and choose **Personalize**.
  b. Select **Adjust font size (DPI)** and choose **Larger scale (120 DPI)**.
     To define other font size schemes, choose **Custom DPI**.
  c. In the right-hand pane, select **Window Color and Appearance**.
     Select a color scheme from the **Color scheme** drop-down box.
     To define your own color schemes, choose **Advanced**.

- **Running the Installer in Accessibility Mode**
  You perform a remote installation as follows:

  a. Start the installer on the remote host by executing the following command from the command line as described in Performing a Remote Installation (Java SDT GUI only) [page 48]:

     `<Path_To_Unpack_Directory>/sapinst`

  b. Start the installer GUI on a local Windows host by executing the following command from the command line as described in Starting the Java SDT GUI Separately [page 50]:

     `<Path_To_Unpack_Directory>\sapinstgui.exe -accessible -host <Remote_Host> - port <Port_Number_Gui_Server_To_Gui_Client>`
4.3.6 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

Context

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error

Procedure

1. Check SAP Note 1548438 for known installer issues.
2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   - Try to solve the problem:
     - To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose:
       - The LOG FILES tab, if you are using the SL Common GUI.
       - The View Logs menu item, if you are using the Java SDT GUI.
     - To check the log and trace files of the installer GUI for errors:
       - If you use the SL Common GUI, you can find them in the directory <User_Home>/sapinst/.
       - If you use the Java SDT GUI, you can find them in the directory <User_Home>/sdtgui/.
       - If the GUI server or the installer GUI do not start, check the file sdtstart.err in the current <User_Home> directory.
       - If the installer GUI aborts without an error message, restart the installer GUI as described in Starting the Installer GUI Separately [page 50].
       - If you use an X Server for Microsoft Windows or other remote desktop tools for the Remote Access of the Java SDT GUI on Windows workstations and you experience display problems such as missing repaints or refreshes, contact your X Server vendor. The vendor can give you information about whether this X Server supports Java Swing-based GUIs and also tell you about further requirements and restrictions. For more information, see SAP Note 1170809.
   - Then continue by choosing Retry.
   - If you cannot resolve the problem, abort the installer by choosing one of the following, depending on the type of installer GUI you use:
     - If you use the SL Common GUI, choose Cancel in the tool menu.
     - If you use the Java SDT GUI, choose Stop from the error message or SAPinst Exit Process in the tool menu.
     
     For more information, see Interrupted Processing of the Installer [page 45].
3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*.
For more information about using subcomponents of BC-INS*, see SAP Note 1669327.
5 Post-Installation Activities

5.1 Gateway Configuration

You have to configure the gateway to be able to use it.

You can find the configuration documentation in the SAP Library [page 10] at: SAP NetWeaver Library: Function-Oriented View ➔ Application Server Infrastructure ➔ Connectivity ➔ Gateway ➔
6 Additional Information

6.1 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

Context

Procedure

Proceed as described in SAP Note 962955.

6.2 Starting and Stopping with Commands

Use

You check that you can start and stop the standalone Gateway by running the `startsap` and `stopsap` commands.

Procedure

Starting the Instance

1. Log on as user `<sapsid>adm` to the standalone Gateway host.
2. Execute the command `startsap all G<XX>`, where `<XX>` is the instance number of the standalone Gateway.

   **Example**
   
   If the instance number is 00, then the command is `startsap all G00`.

   The startup log is written to `/home/<sapsid>adm/startsap_GXX.log`.

**Stopping the Instance**

1. Log on as user `<sapsid>adm` to the standalone Gateway host.
2. Execute the command `stopsap all G<XX>`, where `<XX>` is the instance number of the Gateway.

   **Example**
   
   If the instance number is 00, then the command is `stopsap all G00`.

   The shutdown log is written to `/home/<sapsid>adm/stopsap_G<XX>.log`.

### 6.3 Uninstall

**Use**

The following procedure describes how to uninstall a standalone Gateway using the installer.

**Procedure**

1. Start the Installer [page 39].
3. Follow the instructions in the installer screens.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for information relating to SAP’s use of third party software with or within SAP NetWeaver.